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The cadastral editor introduces a new set of tools for maintaining land 
records in ArcGIS Survey Analyst 9.2 
In this tutorial, you will be introduced to the cadastral fabric dataset. A 
cadastral fabric is a seamless parcel boundary network, which is created and 
maintained using data from survey plans. You will create a cadastral fabric 
and migrate some existing parcel-based GIS data from Alachua County, 
Florida, into your cadastral fabric. In the following exercises you will edit 
the cadastral fabric and add new parcel data from the Timberbrook and 
Edgewood survey plans. 
When adding parcel data from survey plans, you are essentially updating 
your cadastral fabric (boundary network) with new survey measurements. 
The Least Squares Adjustment adjusts the cadastral fabric in response to 
these new measurements and finds a new “best-fit” for all the parcel corners. 
Many geographic information systems use cadastral records to build the 
base map for all other layers in the GIS. As the cadastral fabric is adjusted, 
overlying GIS layers will fall out of alignment with the parcel base map. 
In exercise 7, you will run a GIS feature adjustment which applies the 
coordinate shifts resulting from the Least Squares Adjustment to your 
overlaying GIS feature classes. The GIS feature adjustment will bring your 
GIS layers back into alignment with your updated cadastral fabric.

Cadastral Editor Tutorial for Survey Analyst

• Exercise 1: Organizing the tutorial 
data

• Exercise 2: Creating and managing 
a cadastral fabric

• Exercise 3: Creating new parcels 
in fabric jobs

• Exercise 4: Working with parcel 
construction tools

• Exercise 5: Adding control points 
to your cadastral fabric

• Exercise 6: Appending groups of 
parcels to the cadastral fabric

• Exercise 7: Adjusting your 
cadastral fabric 
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To work with this tutorial, you will need to have the ArcGIS 
Survey Analyst extension installed. Before you can begin 
the tutorial, you must find and organize the data you will be 
working with. Using ArcCatalog, browse for and create a 
new folder connection to your data:
1. Click the start menu, point to Programs, point to 

ArcGIS and click ArcCatalog. 
2. Navigate to the location of the tutorial (the default path 

is \arcgis\ArcTutor on the drive where you have ArcGIS 
installed).

3. Select the Cadastral Editor folder and copy the folder to 
your local drive.

The tutorial data is now copied to your local drive.

Connecting directly to your tutorial data

Folder connections in ArcCatalog simplify the task of 
navigating to your most frequently used datasets.
1. On the Standard toolbar in ArcCatalog, click Connect to  

Folder 
2. In the Connect to Folder dialog, navigate to and select 

your local copy of the Cadastral Editor tutorial folder.
3.  Click OK.
Your new folder connection is now listed in the Catalog 
tree. You will now be able to access all the data needed for 
this tutorial through this connection.

Enabling the Survey Analyst Extension

Before you can begin working with the cadastral editor, you 
need to enable the Survey Analyst extension:
1. In ArcCatalog, click the Tools menu on the Main Menu 

toolbar. 
2. Click Extensions... 
3. Check the Survey Analyst checkbox in the Extensions 

dialog.

Exercise 1: Organizing the tutorial data

4. Click Close.
The Survey Analyst extension is now enabled.
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Exercise 2: Creating and managing a cadastral fabric

In this exercise, you will create a new cadastral fabric 
dataset. Most cadastral fabrics will use, as a starting point, 
existing parcel data from GIS and CAD layers. You will 
migrate existing parcel-based GIS data from Alachua 
county into your cadastral fabric. Later on in the exercise, 
you will load the cadastral fabric dataset as a layer into 
ArcMap.

Creating a new cadastral fabric dataset

Cadastral fabric datasets are created as new nodes under 
feature datasets in ArcCatalog:
1. In ArcCatalog, click the plus sign next to your new 

cadastral editor folder connection. Click the plus sign 
next to the TutorialData folder to expand its contents. 
Click the plus sign to expand the AlachuaCounty 
geodatabase.

 
2. Right-click the ACPA feature dataset, point to new and 

click Cadastral Fabric...

A new cadastral fabric dataset called “NewFabric” will 
appear as a new node under the ACPA feature dataset.

Migrating data into the cadastral fabric

To migrate parcel-based GIS data successfully into a 
cadastral fabric, the GIS feature classes need to be aware 
of the cadastral fabric data model. Cadastral  fabric parcel 
polygons are comprised of a set of lines which have 
two end points. The cadastral fabric has its own internal 
arc-node topology. Any GIS data being migrated into a 
cadastral fabric needs to have arc-node topology. Parcel 
lines need to be aware of their common endpoints and of 
their left and right parcel polygons.
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1. Double-click the ACPA feature dataset in the 
AlachuaCounty geodatabase to expand its contents.

There are three parcel-based feature classes:   
AlachuaParcel_arc,  AlachuaParcel_node and 
AlachuaParcel_polygon.
2. Select each feature class and click the Preview tab in 

the right-hand pane to view the features.

 
The AlachuaParcel_arc feature class defines the parcel lines 
that make up the parcel polygons, the AlachuaParcel_node 
feature class defines the common end-points of the parcel 
lines and the AlachuaParcel_polygon feature class defines 
the parcel polygons.
You will now migrate the GIS parcel-based feature classes 
into your cadastral fabric:
3. Click on the Contents tab in the right-hand pane to 

switch out of preview mode in ArcCatalog.
4. Right-click the cadastral fabric dataset you just created 

under the ACPA feature dataset. Point to Import and 
click Fabric Data

The Cadastral Data Importer wizard appears.
 

 

5. Click the open file button  to locate the GIS feature 
classes containing your fabric source data. 

Fabric source GIS feature classes should all have the same 
name. The parcel lines feature class should be underscored 
with “_arc”, the parcel polygon feature class should be 
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underscored “_polygon” and the parcel node feature class 
should be underscored “_node”.
6. In the Select a COGO feature class to import dialog, 

navigate to ACPA feature dataset in the AlachuaCounty 
geodatabase in your cadastral editor\tutorialdata folder. 
Select the AlachuaParcel_arc feature class.

 
Since all three fabric source feature classes are named the 
same, you just need to select one fabric source feature class 
and the importer will identify the remaining two fabric 
source feature classes.
7. Click Next.
Now you will specify the measurement units of the COGO 
attributes of your fabric source data. Note that your fabric 
source data does not necessarily need COGO attributes. If 
your data has none, the dimension data will be inversed and 
generated from the shape fields of the fabric source feature 
classes.
8. Click the drop-down list for Direction and angle 

units and select Degrees Minutes Seconds. Click the 
drop down list for Direction type and select Quadrant 
Bearing.

 
Note that distance units are inherited from the spatial 
references of the feature classes
9. Click Next.
Now you will set some data migration tolerances for your 
fabric source data:
10. Enter 5 feet for Radial point tolerance. Radial point 

tolerance is the maximum amount by which two 
successive curve radii can vary, for them to be 
considered the same radius, with the same center point.

Accept the default for the Link to control tolerance. You 
will import control points in a later exercise.
11. For inversed line accuracy category, leave the default 

as 6. If you fabric source data has no COGO attributes, 
the dimension data will be inversed from the shape 
fields. These parcel lines will be given a low accuracy 
category.
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12. Click Next to view the data migration summary.
13. Click Finish to start the data migration process.
14. Once the data migration has completed, click the 

Preview tab on the right-hand pane in ArcCatalog to 
preview the data in your cadastral fabric.

Managing your cadastral fabric

The internal tables and feature classes that make up 
a cadastral fabric act just like normal feature classes 
in ArcCatalog. You can add attributes to, and create 
relationship classes with, fabric classes and tables. You can 
also add subtypes and domains. 
You will now create a relationship class between the 
cadastral fabric and the parcel ownership data for Alachua 
county.
1. Right-click the ACPA feature dataset, point to New and 

click Relationship Class...
The New Relationship Class wizard will appear.
2. Type in “FabricParcels_Owners for the name of the 

relationship class.
3. For the origin feature class, expand the ACPA feature 

dataset and select NewFabric_Parcels. For the 
destination table, select Alachua_Owners.

 
4. Click Next.
5. For the relationship type, keep Simple (peer to peer) 

relationship selected.
You will notice that Composite relationship is greyed out. 
This is because a cadastral fabric cannot participate in a 
composite relationship, where data in a cadastral fabric 
table could be altered by changes in the related table. 
6. Click Next.
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7. Accept the default labeling and message propagation 
settings and click Next.

8. Click 1-M (One to Many) for the cardinality of the 
relationship class (one parcel can have many owners). 
Traditionally, you would define a M-N (Many-Many) 
relationship between parcels and owners but for 
the purposes of this tutorial, you will define a 1-M 
relationship  

9. You will not add any attributes to the relationship class. 
Keep the default option selected.

10. Click the drop-down list for the primary key in the 
origin feature class (NewFabric_Parcels) and select 
“Name”. 

11. Click the drop-down list for the foreign key in the 
destination table (Alachua_Owners) and select “ID”.

 
12. Click Next to view the relationship class summary.
13. Click Finish.
The new FabricParcels_Owners relationship class appears 
under the ACPA feature dataset.

 

Associating GIS feature classes to your cadastral 
fabric

When you run a Least Squares Adjustment on your 
cadastral fabric, new coordinates are computed for the 
parcel corner points. Parcels in the cadastral fabric will 
thus adjust over time. GIS features classes that use the  
parcel boundaries as a basemap, will fall out of alignment 
with adjusted parcels . The GIS feature class adjustment 
in the cadastral editor captures the shifts between the old 
and new coordinates of the adjusted cadastral fabric, and 
applies these shifts as displacement vectors to GIS feature 
classes to bring them back into alignment with the adjusted 
cadastral fabric. To be able to run a GIS feature class 
adjustment on your GIS data, you need to associate the 
feature classes to your cadastral fabric.
1. Right-click your cadastral fabric in the ACPA feature 

dataset and click Properties
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2. In the Cadastral Fabric Properties dialog, click the 

Associations tab.
3. Click the Add button.

 
4. In the Associate Feature Classes dialog, navigate to the 

GRU feature dataset in the AlachuaCounty geodatabase, 
select the Roads and Buildings feature classes and click 
Add.

Both the Roads and Buildings feature classes are now listed 
as associated feature classes. Note that the adjustment date 
for both feature classes is set to “Not yet adjusted” until 
they participate in a GIS feature class adjustment. When 
the feature classes are adjusted in a GIS feature class 
adjustment, the adjustment date will be set to the date of the 
last feature class adjustment.
5. Click OK to close the Cadastral Fabric properties dialog 

and apply the changes.

Viewing the cadastral fabric in ArcMap

In this section you will add your cadastral fabric dataset 
as a cadastral fabric layer into ArcMap. The cadastral 
fabric is loaded as a group layer into ArcMap. The internal 
feature classes that make up the cadastral fabric are sub-
layers under the cadastral fabric group layer. These fabric 
sublayers can be queried, symbolized and displayed just 
like normal feature class layers in ArcMap. 
1. Open ArcMap by clicking the Launch ArcMap button 

 on the Standard toolbar in ArcCatalog. Close the 
“Start using ArcMap with” dialog, if it appears.
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2. In ArcMap, click the File menu and click Open...
3. In the Open dialog, navigate to the Cadastral Editor 

tutorial folder on your local drive.
4. Select the AlachuaCounty ArcMap document in the 

\Cadastral Editor\ folder and click Open.
 

ArcMap displays a map of your cadastral fabric, with the 
roads and buildings GIS feature classes. The cadastral 
fabric group layer is made up of the Control, Line points, 
Points, Lines and Parcels sublayers. These are the internal 
feature classes that make up the cadastral fabric. The Lines 
sublayer has several line categories, with each category 
representing an internal cadastral fabric line type. The 
radial lines (shown in light grey) are displayed for curved 
boundaries, and they extend out to the center point of each 
curve boundary in the cadastral fabric.
For now, turn the display of the GIS feature classes off. We 
will work with them later:
5. In the table of contents (TOC), uncheck the Buildings 

and Roads GIS feature classes. Save the map document.

 (File -> Save).
You will now use the Identify tool to examine the attributes 
and relationships of a parcel in the cadastral fabric. First, 
you need to zoom in a little closer to the area you will be 
working with:
6. In ArcMap, click the View menu on the Main Menu 

toolbar, point to Bookmarks and click Timberbrook.

 

The map display zooms to the extent of the parcels in the 
Timberbrook survey plan.

7. Click the Identify tool  on the Tools toolbar. (If 
the Tools toolbar is not present, Click View, point to 
Toolbars and click Tools.)

8. Using the Identify tool, click on a parcel in the map 
extent.

9. Make sure NewFabric parcels are selected in the 
Identify from drop down list.
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The Identify dialog displays the attributes of the parcel you 
selected.

 

10. Click the plus sign next to the parcel PIN.
The parcel’s related lines, plan information and accuracy 
information appear. The related parcel ownership 
information (Alachua_Owners) is also displayed. This is 
from the relationship class you created earlier.

 
11. Click the plus sign next to Lines to view the parcel lines 

that make up the parcel polygon.

 

The parcel lines store the survey measurement record 
information. Each parcel line stores dimension information, 
which comes from the associated survey plan.
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Since the parcel data was migrated, only the Plan name 
information is displayed. Later on, you will populate the 
remaining plan attributes.
16. Close the Identify dialog.

12. Click on each parcel line to view its attributes. The 
parcel line will also flash green in the map extent.

13. Click the plus sign next to one of the parcel lines
The To and From points of the parcel line is displayed in the 
Identify dialog The parcel line’s associated accuracy infor-
mation is also displayed.. You can click on the To and From 
points in the Identify dialog to view their attributes and to 
flash them on the map screen.

14. Click the plus sign next to Alachua_Owners to view the 
ownership information for the identified parcel.

15. Click the plus sign next to Plans to view the parcel’s 
associated plan information.
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Exercise 3: Creating new parcels in fabric jobs

In this exercise you will add a new parcel to the cadastral 
fabric using a parcel traverse. The new parcel is part of the 
Timberbrook survey plan. Whenever you edit your cadastral 
fabric, you need to select and extract the parcels you are 
working with, out into a fabric job. Fabric jobs are created 
automatically for you during the extraction process.. You 
can also manually create a custom fabric job and provide 
job title, operator and a job description. You will create a 
custom fabric job in a later exercise.

Modifying parcels in the cadastral fabric

You will be working with parcels from the Timberbrook 
survey plan. To view this plan, open the Timberbrook PDF 
file in your Cadastral Editor\TutorialData\ folder on your 
local drive. You will need Adobe Reader to view this file.
1. If ArcMap is not open, restart ArcMap and open the 

AlachuaCounty map document.
2. Open the Timberbrook bookmark to zoom to the extent 

of the Timberbrook survey plan.
Make sure that the Editor and Fabric Editing toolbars are 
loaded in ArcMap:
4. Click the View menu on the Main Menu toolbar, point 

to Toolbars and click Fabric Editing. Do the same for 
the Editor toolbar.

5. Click the Editor menu on the Editor toolbar and click 
Start Editing to start an edit session.

You will now select the parcels you will be working with 
and extract them out into a fabric job:

6. Click the Select Cadastral Features tool  on the 
Fabric Editing toolbar.

7. On the map display, drag a box around the parcels in 
the area of the Timberbrook survey plan.

8. Click the Fabric Editing menu on the Fabric Editing 
toolbar and click Modify...
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The selected parcels are extracted out to a fabric job and 
the fabric job is automatically created in the background. 
The cadastral fabric is now displayed in fabric job mode: 
The parcels that are part of the fabric job are displayed as 
active and are available for editing. The parcels outside of 
the fabric job are displayed as inactive and are not available 
for editing.
A docked Parcel Explorer window is also displayed on the 
map, as well as a docked Parcel Properties window.

The Parcel Explorer lists all the active parcels in the open 
fabric job by their associated survey plan. In the fabric job 
you just created, there are parcels from the Hazel Heights 
survey plan, and the Timberbrook survey plan.
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Entering plan data in the cadastral fabric

Before you create a new parcel in the Timberbrooke survey 
plan, you first need to set the plan units you will be working 
with, as well as some other plan information:
1. Right-click the Timberbrook plan in the Parcel Explorer 
window and click Properties.

 
The Plan Properties dialog appears.
2. Click the Record Format tab. Here you will set the units 
of the Timberbrook plan, and these units will be used when 
entering parcel data into this plan.
3. Click the Direction or Angle Type drop-down list and 

select Quadrant Bearing.
4. Click the Direction and Angle Units drop-down list and 

select Degrees Minutes Seconds.
5. Click the Distance and Length Units and select U.S 

Survey Feet.
Leave the default selection for Area units , you will not 

6. For circular curves, click the Circular Curve Parameters 
drop-down list and select Radius and Arc Length.

7. Click the Circular Curve Direction drop-down list and 
select Tangent.

 
You will now enter some other plan information from the 
Timberbrook plan:
8. Click on the General tab of the Plan Properties dialog. 

You can enter the legal description of the Timberbrook 
plan in the Description text box.

work with them.
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9. Click on the Attributes tab.
10. Enter the Survey Company name and the Survey Date. 

You can get this information from the Timberbrook 
PDF file in your \Cadastral Editor\TutorialData folder 
on your local drive.

11. Click OK on the Plan Properties dialog to apply your 
changes.

Entering parcel data using the parcel traverse

You will complete the Timberbrook survey plan and enter 
in the missing parcel:
1. Right-click the Timberbrook plan in the Parcel Explorer, 
and click New Parcel...

The data frame switches from the open fabric job to a new, 
blank data frame for parcel editing. You will essentially 
enter in the parcel data in its own local coordinate space. 
In most cases, there is no coordinate or spatial reference 
information on a survey plan, there is only dimension 
information. Data entry in the cadastral editor is tailored to 
an environment where only dimensions are known, with no 
coordinates or spatial reference information. 
In the parcel edit data frame in ArcMap, the docked Parcel 
Properties window has become active. 
2.  In the Parcel Properties window, make sure the 
Timberbrook plan is selected.
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3. Type “07916-041-033” in the empty field next to the 
parcel Name field and push <Enter> on your keyboard. 
This is the parcel PIN.

 
4. Click on the Lines tab of the Parcel Properties window.
An empty parcel traverse grid appears. You may need to 
expand the Parcel Properties window to see the full grid.
 

5. Click on the Bearing field to enter the first leg of the 
parcel traverse. Enter a bearing of “N89-52-06W”. 
Click Tab to enter a Distance of “82” feet.

6. Push <Enter> on your keyboard to display the first 
traverse leg in the construction data frame.

You do not need to populate the From and to fields as they 
are populated automatically.

7. Enter in the dimension data for the second parcel 
traverse leg: Enter a bearing of “N00-13-00E” and a 
distance of “72.26” feet. You can also enter “00-13-00-
1” as an alternative. “1” Being the 1st quadrant.



18

8. Enter in the circular curve dimension data for the third 
leg of the parcel traverse: Enter a bearing of “N00-13-
00E”, a radius of “25” feet and an arclength of “39.23” 
feet.

 

9. Enter in dimension data for the fourth leg of the parcel 
traverse: Enter a bearing of “S89-52-06E” and a 
distance of “57.05” feet.

 
10. Enter in the fifth and final leg of the traverse to close 

the parcel. Enter a bearing of “S00-13-00W” and a 
distance of 97.25” feet. This time you will enter a To 
point of “1” which is the starting point of the parcel:

Once you close the parcel traverse back on its starting point, 
misclosure information for the parcel is displayed at the 
bottom of the Parcel Properties window. The misclosure is 
the difference between the starting point of the first traverse 
leg and the ending point of the last traverse leg. The parcel 
misclosure should be as small as possible. The misclosure 
for the parcel you just entered is 0.0289 feet, which is 
within acceptable limits. 

Large misclosures indicate either a data entry error, or a 
problem with the survey data.
11. Click the Save on the Parcel Construction toolbar to 

save your parcel traverse.

The data frame switches back to the active parcels in your 
fabric job and the newly created parcel is listed as an 
unjoined parcel in the Parcel Explorer.
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New parcels reside in unjoined space in an open fabric job. 
Remember, you created your new parcel with no knowledge 
of coordinates, or of a spatial reference. Your parcel has no 
knowledge of where it fits in the cadastral fabric. For your 
new parcel to become part of the cadastral fabric it has to be 
“fitted” or joined into the cadastral fabric.

Joining a parcel to the cadastral fabric

You will now join your new parcel “07916-041-033” to the 
cadastral fabric:
1.  With the fabric job still open, click the View menu, 

point to Bookmarks and click Join Timberbrooke Parcel 
to zoom into the area where you will be joining the 
parcel.

2. Right-click the unjoined parcel “07916-041-033” and 
click Join.

The unjoined parcel appears as a floating geometry in your 
data extent, and the Join Parcel dialog appears. If necessary, 
drag the parcel to a position where join lines can be easily 
constructed between parcel corners.

3. To establish your first join line, click on the bottom 
right corner of the unjoined parcel and then click on 
its corresponding corner in the cadastral fabric.
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4. Join the bottom left corner.

5. Join the top right corner.

Once you have established three join lines, residuals will 
appear in the Join Parcel dialog. A scale and rotation is also 
displayed.

Join residuals are an indication of how well the unjoined 
parcel fits with the surrounding cadastral fabric parcels. The 
residuals are derived from a difference in measurements 
between the joining parcel’s boundaries and the adjacent 
cadastral fabric parcel boundaries. Large residuals are an 
indication of either an inaccurate cadastral fabric, or of 
problems in the unjoined parcel data. In this case, the join 
residuals are acceptable.
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6. Click OK on the Join Parcel dialog to join parcel 
“07916-041-033” to the cadastral fabric.

The data frame will refresh to display your new parcel as 
one of the active parcels in the fabric job.
To update the cadastral fabric with your changes, the final 
step is to post the fabric job back to cadastral fabric:
7. Click the Fabric Editing menu on the Fabric Editing 

toolbar and click Finish Job.

The fabric job changes are posted back to the cadastral 
fabric.
8. Click the Editor menu on the Editor toolbar and click 

Save Edits to save the changes to the database (or on 
SDE, to the version).

9. Stop the edit session. (Editor -> Stop Editing).
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Exercise 4 : Working with parcel construction tools

In the previous exercise, you learnt how to add a new 
parcel to the cadastral fabric using the parcel traverse. In 
this exercise, you will learn how to create new parcels 
using existing parcel geometry as a template. Using parcel 
construction tools, you will split a parcel block into smaller, 
subdivided parcels. Once again you will edit your parcels in 
a fabric job.

Using parcel construction tools to subdivide an 
existing parcel block

For this exercise, you will re-open the fabric job you 
worked with in the previous exercise. You do not need to 
re-select and extract parcels out to a fabric job every time 
you want to edit the cadastral fabric. If you want to work 
with the same set of parcels already added to a previous 
job, you can just re-open the existing fabric job from the 
job book.
1. If ArcMap is not open, re-open the application and load 

the AlachuaCounty map document.
2.  Make sure your map is zoomed out to the correct 

extent. (View -> Bookmarks -> Timberbrooke).
3. Start an edit session. (Editor -> Start Editing.)
4. Click the Fabric Editing menu and click Job Book... to 

open the fabric job book.
 

The dockable Job Book window appears on the screen. 
5. Re size the Job Book window, if necessary. In the list 

of fabric jobs, you should see the single fabric job you 
worked on in Exercise 3.

You will re-open this fabric job to continue with your parcel 
edits.
6. Select the fabric job in the Job Book window and click 

Open. You can also double-click on the selected fabric 
job to open it.

The parcels in the selected fabric job are extracted again and 
re-opened in the fabric job.
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7. Close the Job Book.
8. Click on the Select Cadastral Features tool and click on 

the large, unsubdivided parcel block in the active fabric 
job. You can also select parcel “07916-041-022” in the 
Parcel Explorer.

9. Right-click on the selected parcel and click Unjoin. 
When editing existing parcel geometry or adding new 
construction lines to an existing parcel, you need to 
unjoin the parcel from the cadastral fabric.

The selected parcel is now listed as an unjoined parcel in 
the Parcel Explorer.

 
10. Right-click the unjoined parcel and click Construction...
   

  
The data frame switches to the parcel edit data frame and 
displays the parcel’s construction lines. You will now use 
the parcel breakline construction tool to split the parcel 
block into its subdivided parcels.
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11. Right-click on the top-most line on the construction 
parcel (line going from point 3 to point 5) and click 
Breakline...

12. On the Breakline dialog, click in the first empty line 
in the Break at distance column and enter “54.03” to 
create your first breakpoint. Click enter.

13. Enter “79.00” on the second line to create your second 
breakpoint. 

14. Enter “79.00” for your third and final breakpoint for the 
line.

15. Click OK. All three breakpoints are created on the 
parcel line.

16. Now right-click the bottom-most parcel line and click 
Breakline...
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You will now add a breakpoint on the left-most line of the 
parcel block:
20. Right-click on the left-most line of the parcel block and 

click Breakline.

The breakpoints you will enter on the bottom line are all at 
an equal distance of 79.00 feet.
17. Click the Switch button to switch the direction of the 

breakline. The breakline direction should be between 
points 1 and 9.

18. On the first breakpoint line, enter “79” and then a space 
and the number “3”. Push Enter on your keyboard. 

This is a quick method of adding equally spaced 
breakpoints in succession on a parcel line.

19. Click OK to close the Breakpoint dialog. 
The three new breakpoints on added on the bottom-most 
parcel line.

21.  On the Breakline dialog enter “100”. The breakline 
must be between points 1 and 2 (breakline going from 
bottom to top).
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18. Click OK to create the breakpoint. 
Your parcel block should now have the following 
breakpoints:

You will now add a construction line between the 
breakpoints on the left and right parcel lines (between 
points 16 and 8 ).
19. Scroll down on the construction line grid and click in 

From field of the first empty grid line.

20. Snap on point 16 and then snap on point 8 to construct a 
line between points 16 and 8.

The construction line’s parameters are populated in the 
construction grid.

21. Right-click on the line you have just added and click 
Breakline... to add breakpoints to this line (Breakline 
between points 16 and 8.)

22. In the Breakline dialog, enter “79 3” to enter three 
equally spaced breakpoints at 79 feet apart.
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 Click OK
Your parcel should now have the following breakpoints:

You will now construct vertical lines between the 
breakpoints to split the parcel block into smaller, subdivided 
parcels.
23. Scroll down to the bottom of the construction line grid 

and click in the From field of the first empty line.
24. Snap on breakpoints 10 and 17, 11 and 18, 12 and 19 to 

add three lines to the top half of the parcel block.

25. Snap on breakpoints 17 and 15, 18 and 14, 19 and 13 to 
complete the subdivision of the parcel block.

26. Click the Build Parcel  button on the Parcel 
Construction toolbar to build parcels from the newly 
added construction lines and points.

27. Click Save on the Parcel Construction toolbar to save 
the parcels as unjoined. 

The newly subdivided parcels are saved as unjoined parcels 
under a new plan node called New Construction.
28. In the Parcel Explorer, right-click each of the two 

existing, unjoined parcels under the Timberbrook plan 
node and click Delete Unjoined to delete each parcel.
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The subdivided parcel group will appear as floating 
geometry in the data extent.
3. If necessary, drag the parcel geometry to a place where 

you can easily pair up your join lines.
4. Join the three parcel points on the right end of the 

parcel group to their corresponding points in the 
cadastral fabric. Join the top-most parcel curve center 
point as well.

5. Click OK to accept the join lines and to join the parcel 
group to the cadastral fabric.

If you want to rename the newly joined parcels, right-click the parcel 
in the Parcel Explorer and click Open...Type a new name for the parcel 
and click Save on the Parcel Construction toolbar.

6. Click the Fabric Editing menu and click Finish Job to 
post your changes back to the cadastral fabric.

7. Click the Editor menu and click Save Edits to save your 
changes.

8. Stop Editing and close ArcMap.

Joining a group of parcels to the cadastral fabric
You will now join the newly subdivided parcel group into 
the cadastral fabric.
1. With your fabric job still open, zoom into the parcel 

join area on the map.
2. Right-click one of the unjoined parcels in the Parcel 
Explorer and click Join.
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Exercise 5 : Adding control points to your cadastral fabric

In a Least Squares Adjustment of the cadastral fabric, 
control points are used as a basis for improving the 
spatial accuracy of all other parcel points in the network. 
Control points are held as fixed points in the Least-Squares 
Adjustment and “pin down” or constrain the cadastral fabric 
at strategic locations. Control points are processed together 
with the parcel measurements to derive new, more accurate 
coordinates for connected parcel points in the network.
In this exercise, you will import control points into the 
cadastral fabric from an existing feature class. Control 
points can also be entered manually in a fabric job. You will 
enter a new control point into the Timberbrook survey plan. 

Importing control points from a feature class into 
the cadastral fabric

1. Open ArcCatalog if it is not already open.
2. Open the connection you created to your tutorial 

data in Exercise 1. Navigate to your cadastral fabric 
(NewFabric) in the ACPA feature dataset.

3. Right-click on the cadastral fabric, point to Import and 
click Control Points.

The Cadastral Data Importer wizard will appear.

4. Click the Open File button  and navigate to the 
Control feature class in the ACPA feature dataset. 

5. Select the Control feature class and click Add on the 
Select a COGO feature class to import dialog. 

6. Do not check the Use shape field for coordinates box.
The control feature class has X, Y, Z coordinate attributes 
and the importer will be using these attribute coordinates. 
If your control point feature class has no X,Y,Z coordinate 
attributes, you can check the Use shape field for coordinates 
box. The importer will then obtain the X,Y, Z coordinates 
from the shape field of the feature class.
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7. Click Next
8. Enter “6” feet for the Link to control tolerance value.

The Link to control tolerance is the tolerance used when 
matching control points to parcel points in the cadastral 
fabric. Control points must be linked to a parcel point in the 
cadastral fabric for connectivity to the network and to be 
included in the Least Squares Adjustment of the network. If 
a cadastral fabric is inaccurate, parcel points in the cadastral 
fabric may not match the locations of their control points. If 
this is the case, control points can be linked to parcel points 
that lie within a specified distance (tolerance) of the control 
points.
9. Click Next to view the import summary and click 

Finish to import the control points.
10. Open ArcMap and re-open the AlachuaCounty map 

document in your \cadastral editor\ folder.
The control points should now be visible on the map.

If the importer was unable to find fabric points within the specified 
tolerance, the imported control points will not be able to participate 
in a Least-Squares Adjustment.  In this case, you can use the manual 
control point link tool to associate control points to their parcel points.

11. Zoom into the Timberbrooke survey plan on the map 
(View -> Bookmarks->Timberbrooke)

You will notice that the fabric parcel points do not exactly 
match the locations of their control points. This is because 
the control data is more accurate than the parcel data. The 
fabric points do however, all fall within the specified 6 foot 
tolerance and are linked to their control points.  
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Adding control points manually to the cadastral 
fabric

In addition to importing control points, you can also 
manually enter in control points to your cadastral fabric. 
You will now manually enter a control point from the 
Timberbrooke survey plan:
1. Click the Editor menu and click Start Editing to start 

and edit session.
You will add a control point to top-right corner of the Tim-
berbrooke survey plan parcels.
2. Click the Select Cadastral Features tool on the Fabric 

Editing toolbar and drag a box to select the parcels in 
the area where you will be adding a control point.

The grid on the Control dialog is populated with the parcel 
point ID (Associated parcel point ID), a default control 
point name and the Easting and Northing values from the 
parcel point. You will re-enter the Easting and Northing 
values of the control point as the parcel point coordinates 
do not match the coordinates of the control point.
6. In the Control dialog, click the value of the Easting 

coordinate and enter the value “2650002.10. For the 
Northing value, enter “258807.20”.

3. Click the Fabric Editing menu and click Modify... to 
extract the selected parcels into a fabric job.

3. Zoom to the active parcels in the open fabric job.

4. Click on the Maintain control points  button on the 
Fabric Editing toolbar.

The control dialog will appear on your screen. 
5. Click the New button on the Control dialog and click on 

the top right parcel corner point (point 3042) of the top 
right parcel in the Timberbrook survey plan.
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7. Click Update to add the new control point to the control 
points list and to the active fabric job. Close the control 
dialog.

The control point will appear in its correct location on the 
map.

8. Click the Fabric Editing menu and click Finish job to 
post your changes back to the cadastral fabric. Save 
your edits and stop the edit session.



33

Exercise 6 : Appending groups of parcels to the cadastral fabric

So far, you have seen how to add new parcel data to 
a cadastral fabric using the parcel traverse and parcel 
construction tools. You can also append groups of parcels to 
your cadastral fabric in the form of XML files. This would 
be the equivalent of a digital submission of parcels. In this 
exercise you will append a subdivision of parcels from the 
Edgewood survey plan.
1. To view the Edgewood survey plan, navigate to your 

\cadastral editor\TutorialData folder in windows 
explorer. Open EdgewoodPhase1.pdf

Creating a custom fabric job

1. If ArcMap is not already open, open the application and 
load the AlachuaCounty map document.

2. Click the View menu, point to Bookmarks and click 
EdgewoodAppend to zoom the Edgewood survey plan 

You will create a custom fabric job to append the Edgewood 
plan parcels:
3. Click the Editor menu and click Start Editing.
4. Click the Fabric Editing menu and click Create Job...

The custom fabric job dialog appears on the screen.
5. In the empty field next to Name, type 

EdgewoodAppend as the job title.
6. Type an operator name in the empty field next to 

Owner.

In a custom fabric job, you can exclusively lock the 
parcels you want to edit. This is relevant on a multi-user, 
SDE environment. Locked parcels cannot be edited by 
overlapping jobs.
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7. Click the Select  Cadastral Features tool on 
the Fabric Editing toolbar and select the large, 
unsubdivided parcel on your map extent.

8. Click the Add button next to the Locked Parcels list to 
add the selected parcel as a locked parcel to the custom 
fabric job.

The parcel name appears in the Locked Parcels list and 
is displayed in red on the map. For joining purposes, the 
immediate, surrounding neighboring parcels are added 
as unlocked parcels to the fabric job. These parcels are 
displayed in blue and their parcel names are added to the 
list of unlocked parcels.

Neighboring parcels are added by default to a custom fabric 
job. You can add additional surrounding, unlocked parcels 
using a radius buffer, or by manually selecting parcels.
9. Click the Parcels within option and enter a radius of 

100 feet.
10. Select Feet from the units drop down list.

11. Click the Get button.
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A radius buffer line is displayed on the map and all parcels 
intersecting with this line are added as unlocked parcels to 
the fabric job, and displayed in blue.

12. Leave the Include parcels to fill gaps in the selection 
and Open job when I click OK options checked, and 
click OK to open the fabric job.

The parcels are extracted out into a fabric job. The locked 
parcel is displayed with a locked icon  in the Parcel 
Explorer.

Flagging parcels as historic

Before you append the Edgewood Phase 1 subdivision of 
parcels to the fabric job, you will mark the existing parcel 
block as historic.
1. With the fabric job still open, right-click the locked 

parcel (“07915-011-004”) in the Parcel Explorer and 
click Historic to turn on the historic flag for the parcel.

2. Right-click in empty space in the Parcel Explorer and 
click View Historic Parcels.

The locked parcel icon changes to the historic parcel icon.
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3. Turn the display of historic parcels off. (Right-click 
in empty space in the Parcel Explorer and click View 
Historic Parcels)

The historic parcel block is no longer visible on the map.

Appending parcels to a fabric job

1. With the fabric job still open, click the Fabric Editing 
menu and click Append file...

2. In the Open dialog, navigate to your \cadastral editor\
TutorialData\ folder on your local drive and select the 
EdgewoodPhase1.xml file.

3. Click Open.
The Edgewood1 plan parcels are loaded as unjoined parcels 
in the fabric job.

Joining a parcel group to the cadastral fabric

You will now join the Edgewood1 unjoined parcel group:
1. With the fabric job still open, zoom closer into the join 

area.
2. Right-click any of the unjoined parcels in the 

Edgewood1 plan and click Join.
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The geometry of the parcel group is floated on the map 
extent. 
3. Click anywhere within the parcel group geometry 

and drag the geometry to position the unjoined parcel 
corners for joining.

4. Snap on the top left corner of the parcel group and snap 
on its corresponding corner in the cadastral fabric to 
create the join line.

5. Join the top right corner.
As you join corners, you can click anywhere within the 
parcel geometry to move it into positions for easier joining 
of the parcel corners. You can also zoom in and out.

6. Now join the three bottom left corners of the parcel 
group

7. Join the bottom four right corners of the parcel group.
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8. Click Auto Join on the Join dialog to pick all remaining 
join lines

The join residuals are all within acceptable limits
9. Click OK on the Join Parcel dialog to accept the join.
The appended subdivision parcels are now active parcels of 
the open fabric job.
Post your job changes back to the cadastral fabric:
10. Click the Fabric Editing menu and click Finish job.
11. Click the Editor menu and click Save Edits to save your 

changes.
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Exercise 7 : Adjusting your cadastral fabric

Now that you have added control points to the Timberbrook 
survey plan, you are able to run a  Least Squares 
Adjustment on the parcels in this area. Least Squares 
Adjustments are run on the active parcels in an open 
fabric job. The adjusted parcels are then posted back to the 
cadastral fabric. 
The Least Squares Adjustment processes all the parcel 
line measurements together with the control points to 
derive new coordinates for the parcel points. Taking into 
account the weighting on each parcel line, the adjustment 
essentially finds a new “ best-fit” for the parcel point 
coordinates. Least Squares Adjustments are typically run 
after new parcel data or new control has been added to the 
cadastral fabric. Control points are treated as fixed points in 
a fabric adjustment and do not shift.
Since the Least Squares Adjustment derives new 
coordinates for the parcel corner points, adjusted parcel 
boundaries will shift slightly or significantly, depending 
on how accurate the original parcel data was in relation to 
the new survey data and the control points. As the cadastral 
fabric is adjusted, overlying GIS layers will fall out of 
alignment with the parcel base map. In this exercise, You 
will run a GIS feature adjustment to bring your GIS layers 
back into alignment with your adjusted parcels.

Adding connectivity to a parcel boundary network.

Before you run an adjustment on your parcels, you need to 
ensure there is good connectivity in the network.

1. If ArcMap is not open, restart the application and open 
your AlachuaCounty map document in your \Cadastral 
Editor\ folder. Start an edit session.

2. Zoom to the Timberbrooke survey plan area. (View -> 
Bookmarks -> Timberbrook)

3. Click the Fabric Editing menu and click Job Book to 
open the fabric job book.

You will notice 3 jobs now present in the job book. The 
first job is the automatic job that was created in Exercise 
3. The second job is the automatic job that was created 
when you entered the control point in exercise 5. The third, 
named job is the custom job you created to append the 
EdgewoodPhase1 parcels in exercise 6.  

4.  In the Job book, select the first job you created in 
exercise 3.  Click Open. 
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The Timberbrook survey plan parcels are re-opened in the 
existing fabric job. Notice that the control points are  picked 
up as part of the fabric job as well, since they are linked to 
parcel points in the fabric job.
5. Close the job book.
When running an adjustment on a group of parcels in 
a fabric job, you need to ensure that there is sufficient 
connectivity in the parcel boundary network. There is 
already a connection line that connects the western strip of 
parcels to the eastern block of parcels

However, this connection line is not sufficient to run an 
adjustment on a parcel group of this shape and size. More 
connectivity is needed further south. You will now add one 
more connection line to the parcel network in the job.
6. Click the View menu, point to Bookmarks and click 

AddConnectionLine to zoom in closer to the points you 
will connect.

7. Click the Create Connection tool  on the Fabric 
Editing toolbar.

8. In the Create Connection dialog, click in the empty box 
next to “point 1”.

9. Click on the bottom left corner point of the parcel on 
the right of the empty road space.

The parcel point ID is added to the empty box in the Create 
Connection dialog.
10. Click in the empty box next to “Point 2” and click on 

the bottom right corner point of the parcel on the left of 
the empty road space.

The bearing and distance of the new connection line is 
displayed in the Create Connection dialog.  
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11. Click the OK to create the new connection line.
The map will refresh to display your new connection line.
12. Zoom back out to the extent of the Timberbrook survey 

plan. (View ->Bookmarks ->Timberbrook)

Running a Least Squares Adjustment on parcels 
in a Fabric Job

You will now run a Least Squares Adjustment (LSA) on the 
active parcels in your open fabric job. But first, you need to 
activate the control points that are part of the fabric job.

1. Click on the Maintain Control Points tool  on the 
Fabric Editing toolbar.

The Control dialog appears. You will notice that only one 
control point is active. This is the control point that you 
entered in exercise 5. The migrated control points are all 
still inactive.
2. Click the checkboxes next to the three inactive control 

points to activate them. If a control point is left inactive,  
it will not be used in the LSA. In this way, you can 
exclude “bad” control points from the adjustment.

You can click the Check Fit button on the Control dialog to check the fit 
of your active control points with the existing network. Large residuals 
indicate that the control point does not fit well with the existing network 
and may negatively affect the results of the Least Squares Adjustment.

3. Close the Control dialog.
4. For visual purposes, turn on the display of your roads 

and buildings GIS feature classes in the map. This will 
give you an idea of the misalignment between the GIS 
layers and the fabric parcels after the LSA is applied.

5. Click the Fabric Editing menu and click Adjust.
The Adjust Coordinates dialog appears on the screen. You 
will specify the adjustment tolerances in this dialog before 
you  run the LSA. Adjustment tolerance values are for 
analysis purposes of the LSA results. Large tolerance values 
should be entered when adjusting an inaccurate network 
where much movement and shift is expected in the data. 
Small tolerances should be used when adjusting an accurate 
and stable network. Any movement and shift exceeding the 
tolerance values will be reported in the adjustment report.
6. For the Distances tolerance, enter a value of 1 foot. 

Enter a value of 1 foot for the tolerances for Line points 
and Close points as well. Leave the default of 600 
seconds for the Bearings tolerance.
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The Bearings tolerance is the maximum allowable 
difference between the line computed in the adjustment 
and the original measured line.  The Distance tolerance is 
the maximum allowable difference between the distance 
computed in the LSA, and the original measured distance. 
The Line Points tolerance is a check tolerance that flags 
any line point that lies further away from its line than the 
specified tolerance. Line points can fail to lie on their lines 
due to parcel joining. The Close Points tolerance is a check 
tolerance that flags any points that lie closer together than 
the specified tolerance. 
7. Under Force Plan Structure, check the Straight lines 

tolerance check box. The Straight line tolerance 
enforces the original subdivision structure. A series of 
lines with the same bearing will be kept collinear, if 
they lie within the specified tolerance. Enter a value of 
1 foot for the Straight lines tolerance.

8. Leave the default for the remaining options on the 
Adjust Coordinates dialog and click OK to run the 
adjustment.

The adjustment completes successfully and displays an 
overview of the adjustment results. The adjustment finds no 
close points and no line point errors.

Under the Lines Report, any lines that exceed the specified 
tolerance for Bearings and Distances is reported. 

To view the complete adjustment report, click on the 
Results File button the Least Squares Adjustment Summary 
dialog.
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9. Click Accept on the Least Squares Adjustment 
Summary dialog, to accept the results of the adjustment.

You will notice a slight adjustment in the parcel geometry.
10. Zoom in closer to view the shift between adjusted 

parcel line and the unadjusted parcel lines in the 
cadastral fabric

You will also notice that parcel points are now coincident 
with the location of their linked control points.
11. Zoom back out to the Timberbrook extent and post 

the job back to the cadastral fabric. (FabricEditing -> 
Finish Job).

12. Save your edits.

Adjusting GIS Data using the GIS Feature 
Adjustment 

Now that you have successfully adjusted parcels in your 
cadastral fabric, you will be able to run a GIS feature 
adjustment on GIS features in the area of adjustment. In this 
step, you will adjust the roads and buildings feature classes 
in the Timberbrook survey plan job extent. You will also 
associate and adjust the Timberbrook_Easements feature 
class.
1. With ArcMap still open and the edit session still active, 

right-click on the NewFabric group layer in the TOC 
and click Feature Adjustment... 

The Feature Adjustment dialog will appear .
2. Check the checkboxes for both the buildings and Roads 

feature classes. 
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3. Click the Adjust button on the Feature Adjustment 
dialog to run the feature adjustment.

Once the feature adjustment completes you will notice a 
slight adjustment in both the roads and the buildings feature 
classes.
You will now associate the Timberbrook_Easements feature 
class to the cadastral fabric and adjust the easement data. 
You will first load the Timberbrook_Easements feature class 
into the map.

4. Click the Add Data  button on the Standard toolbar.
5.  In the Add Data dialog, navigate to the Timberbrook_

Easements feature class in the GRU feature dataset.
6. Click Add to display the Timberbrook_Easements 

feature class on the map.
7. Right-click the NewFabric group layer in the TOC and 

click Feature Adjustment.
You will now notice that the Adjusted Date for both the 
roads and buildings feature class has been set to the date 
and time when the Least Squares Adjustment was run. This 
date and time is known as the adjustment level.

8. Click the Add.. button on the Feature Adjustment 
dialog.

9. Navigate to, and select the Timberbrook_Easements 
feature class in the GRU feature dataset. Click Add.

The Timberbrook_Easements feature class is added to the 
Cadastral Feature Adjustment dialog and its adjusted date is 
set to “Not Yet Adjusted”.

10. Check all three feature classes to participate in the 
adjustment.
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11. Click the Adjust button to rerun the feature adjustment.
You will notice that only the Timberbrook_Easements 
feature class is adjusted. That is because the roads 
and buildings feature classes are already at the most 
current adjustment level and are not re-adjusted with 
this adjustment. If you re-open the Cadastral Feature 
Adjustment dialog, you will notice that the Adjusted Date 
for the Timberbrook_Easements feature class is now the 
same as the Adjusted Date for the roads and buildings 
feature classes.
10. Save your edits and close ArcMap. 

Congratulations, you have completed the tutorial!


